Legal notice
Copyright and trademark information relating to this product release.

Copyright © 2000–2020 SDL Group.

SDL Group means SDL PLC. and its subsidiaries and affiliates. All intellectual property rights contained herein are the sole and exclusive rights of SDL Group. All references to SDL or SDL Group shall mean SDL PLC. and its subsidiaries and affiliates details of which can be obtained upon written request.

All rights reserved. Unless explicitly stated otherwise, all intellectual property rights including those in copyright in the content of this website and documentation are owned by or controlled for these purposes by SDL Group. Except as otherwise expressly permitted hereunder or in accordance with copyright legislation, the content of this site, and/or the documentation may not be copied, reproduced, republished, downloaded, posted, broadcast or transmitted in any way without the express written permission of SDL.

SDL Trados Studio is a registered trademark of SDL Group. All other trademarks are the property of their respective owners. The names of other companies and products mentioned herein may be the trademarks of their respective owners. Unless stated to the contrary, no association with any other company or product is intended or should be inferred.

This product may include open source or similar third-party software, details of which can be found by clicking the following link: “Acknowledgments” on page 25.

Although SDL Group takes all reasonable measures to provide accurate and comprehensive information about the product, this information is provided as-is and all warranties, conditions or other terms concerning the documentation whether express or implied by statute, common law or otherwise (including those relating to satisfactory quality and fitness for purposes) are excluded to the extent permitted by law.

To the maximum extent permitted by law, SDL Group shall not be liable in contract, tort (including negligence or breach of statutory duty) or otherwise for any loss, injury, claim liability or damage of any kind or arising out of, or in connection with, the use or performance of the Software Documentation even if such losses and/or damages were foreseen, foreseeable or known, for: (a) loss of, damage to or corruption of data, (b) economic loss, (c) loss of actual or anticipated profits, (d) loss of business revenue, (e) loss of anticipated savings, (f) loss of business, (g) loss of opportunity, (h) loss of goodwill, or (i) any indirect, special, incidental or consequential loss or damage howsoever caused.

All Third Party Software is licensed “as is.” Licensor makes no warranties, express, implied, statutory or otherwise with respect to the Third Party Software, and expressly disclaims all implied warranties of non-infringement, merchantability and fitness for a particular purpose. In no event will Licensor be liable for any damages, including loss of data, lost profits, cost of cover or other special, incidental, consequential, direct, actual, general or indirect damages arising from the use of the Third Party Software or accompanying materials, however caused and on any theory of liability. This limitation will apply even if Licensor has been advised of the possibility of such damage. The parties acknowledge that this is a reasonable allocation of risk.

Information in this documentation, including any URL and other Internet website references, is subject to change without notice. Without limiting the rights under copyright, no part of this may be reproduced, stored in or introduced into a retrieval system, or transmitted in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or for any purpose, without the express written permission of SDL Group.
Contents

1 Legal notice .......................................................... 3

2 Introducing SDL Trados Studio 2021 ........................................ 1
   About this guide .................................................. 2
   Audience for this guide ......................................... 2
   Related documentation ......................................... 2
   About SDL Trados Studio ....................................... 2
   About SDL Trados Studio 2021 ............................... 3
   Licensing .......................................................... 3
   Trial license ....................................................... 4
   Activating your product ........................................ 4
   Trados Studio editions ......................................... 4
   Subscription plans .............................................. 5
   Perpetual licenses .............................................. 6
   Upgrade and Compatibility Information .......................... 7
   Information for upgraders ...................................... 7
   SDL Trados Studio project and package compatibility ....... 7
   Translation Memory Compatibility ............................. 7
   Software .......................................................... 8
   Server-based translation memories ......................... 8
   Local (file-based) translation memories ..................... 8
   MultiTerm compatibility ....................................... 8
   Software .......................................................... 8
   Server-based termbases ...................................... 8
   Local (file-based) termbases ................................ 9

3 Installing SDL Trados Studio 2021 ...................................... 11
   Overview ........................................................ 12
   System requirements .......................................... 12
   Operating systems ............................................ 13
   Software and Internet browsers .............................. 13
   Digital certificate requirements ............................. 13
   Upgrading from an Earlier Version of SDL Trados Studio .. 14
   About the SDL Trados Studio 2021 installer ............... 14
   Prerequisite software ......................................... 14
   Installation location .......................................... 15
Introducing SDL Trados Studio 2021
This chapter gives you an overview of the SDL Trados Studio client installation procedure and the Trados Studio 2021 system.

About this guide

This guide describes how to install and license SDL Trados Studio 2021 desktop application.

This guide does NOT cover:

• Installing the server components of SDL Trados Studio 2021.
• Installing the SDL MultiTerm 2021 application.
• Converting or upgrading existing translation resources to use with SDL Trados Studio 2021.
• Using SDL Trados Studio 2021.

Audience for this guide

This guide is for anyone who is installing any edition of SDL Trados Studio 2021 on a personal computer.

Related documentation

• “SDL Trados Studio 2021 SR1 Migration Guide” on page 0 - contains information about converting or upgrading existing translation resources from SDL Trados 2007 and SDLX so that you can work with them in SDL Trados Studio 2021 SR1.
• SDL Trados GroupShare 2020 Installation Guide - contains information about installing the server components of SDL Trados Studio 2021 and upgrading server-based translation memories from Trados Studio 2009 to the 2021 SR1 format.
• “SDL Trados Studio 2021 SR1 Help” on page 0 - contains information about using SDL Trados Studio 2021 SR1.
• “Translating and Reviewing Documents Quick Start Guide” on page 0 - contains information for translators and reviewers. It focuses on how to translate and review files.
• “Project Management Quick Start Guide” on page 0 - contains information for project managers. It focuses on the project lifecycle.
• “Translation Memory Management Quick Start Guide” on page 0 - contains information for users who create and maintain translation memories.
• SDL MultiTerm 2021 Installation Guide - contains information about installing SDL MultiTerm 2021.

About SDL Trados Studio

SDL Trados Studio is an integrated environment that enables translation teams to share translation tools, resources and project files.

Resources such as translation memories can be shared over an intranet or over the Internet.
You can also use Trados Studio as a single-user tool where the Trados Studio software and translation memories are located on your computer and there is no interaction with translation memories or projects over an intranet or the Internet. Single-users can open and work with project packages created in other Trados Studio installations.

**About SDL Trados Studio 2021**

SDL Trados Studio 2021 contains tools that enable you to:

- Create and manage translation projects, including cloud projects.
- Create and maintain local and server-based translation memories.
- Open documents and translate them.
- Open server-based and local translation memories and apply them to documents.
- Open local and server-based termbases and apply them to documents.
- Update translation memories and termbases during translation.
- Align existing translated documents to generate translation memory content.

In a setup that includes server components, Trados Studio client communicates with server components through an intranet (through a LAN or WAN) or through the Internet using SDL Trados GroupShare. SDL Trados GroupShare includes the following components:

- Project Server
- TM Server
- MultiTerm Server

**Licensing**

When you purchase any SDL software, you must activate it before you can use it. Activation means that the product is licensed for use on the machine where it is installed.

SDL Trados Studio 2021 uses the following license types:

**Single-user license**

You can perform online activation with this type of license using an activation code. You can download the activation code from the SDL Account area on the SDL website when you purchase the software or at a later date. If you do not have access to the Internet on the computer where you have the software installed, you can still activate your product using offline activation.

**Network license**

The administrator performs activation using an activation code on a license server, on a shared network. You can then connect to the server and request a license.

**Subscription license**

You can also activate SDL Trados Studio 2021 and later with a subscription license available for one of the following SDL cloud offerings:

- SDL Language Cloud Translation Management
Trados Live Team
SDL Trados Live Essential

An SDL Trados Studio subscription provides an alternative to permanent licenses and includes SDL Trados Live Essential with the following benefits:
- access to cloud projects
- lower entry price and the ability to pay-as-you-go
- guaranteed updates

**Trial license**

SDL Trados Studio 2021 includes a 30-days trial license.

**Available features**

During the product’s trial period, you can try all the features that the full-fledged edition of that product has to offer (for example the SDL Trados Studio Professional edition).

After the trial period expires, if you decide to purchase another edition of the SDL product that better suits your needs (for example the SDL Trados Studio Starter edition), bear in mind that some of the features available in the Trial Mode will not be available after you activate your license.

For more information about the differences between the available SDL Trados Studio editions, consult this link: [SDL Trados Studio editions comparison table](#).

**Product activation during the trial period**

To continue using the product after the trial period expires, you must purchase a permanent or subscription licence from the SDL Website and then activate your product.

If you are using a trial license and you want to switch to an activate license, open the **Help** tab > **Product activation** and choose the **Perpetual License** or **Language Cloud Subscription** tab. If you activate your SDL product during its 30-day trial period and then deactivate the license, you will be able to continue using the product for the remaining trial period.

**Activating your product**

To learn how you can activate SDL Trados Studio, read the instructions from the [SDL Licensing Help](#).

**Trados Studio editions**

Starting with SDL Trados Studio 2021, you can also activate Trados Studio either with a perpetual or a subscription license. For organizations whose translation team needs to scale rapidly or have varying workloads, purchasing Studio 2021 licenses on an annual subscription may be the best option. Other companies who may prefer to fix their costs at the outset may prefer to opt for perpetual licenses.
Perpetual licenses

With a perpetual license, the initial cost may be higher. However, the license does not expire and you own the software outright, meaning you may use it for many years to come.

You will receive updates and service releases for Studio 2021 for as long as SDL supports the version. Should you wish to upgrade to future editions of Studio, you'll need to pay for the upgrade.

Access to SDL Support is available through a Support and Maintenance Agreement (SMA) at an additional cost.

Subscription licenses

When you purchase an annual subscription for Trados Studio 2021, the initial cost may often be lower. However, you do not own the software outright, and access to the software is for the duration of your subscription. During your subscription, you will receive updates and service releases. You'll also receive upgrades to future editions of Trados Studio, ensuring you continue to benefit from the new functionality and enhancements when released.

With a subscription, you will have the flexibility to easily add extra licenses for new team members and also cancel at the end of your contract. Access to SDL Support is available at an additional cost.

Subscription plans

The following subscriptions are available to meet the different needs of freelance translators, Language Service Providers and corporate or government customers:

<table>
<thead>
<tr>
<th>Subscription type</th>
<th>Availability</th>
<th>Cloud benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDL Trados Live Essential</td>
<td>Free with SDL Trados 2021 Freelance and Freelance Plus</td>
<td>• Cloud storage and resources</td>
</tr>
<tr>
<td>Freelance</td>
<td></td>
<td>• Access to the Online Editor</td>
</tr>
<tr>
<td>SDL Trados Live Essential</td>
<td>Free with SDL Trados 2021 Professional and Professional Network (one Trados</td>
<td>• Web project Dashboard</td>
</tr>
<tr>
<td>Professional</td>
<td>Live subscription for every network license)</td>
<td>• Access to SDL Trados Live mobile app</td>
</tr>
<tr>
<td>SDL Trados Live Team</td>
<td>Purchase from Sales representatives</td>
<td>All Essential benefits + sharing capabilities</td>
</tr>
<tr>
<td>Starter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SDL Trados Live Team</td>
<td>Purchase from Sales representatives</td>
<td></td>
</tr>
<tr>
<td>Standard</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SDL Trados Translation</td>
<td>Purchase from Sales representatives</td>
<td>All Team benefits + complex workflow capabilities</td>
</tr>
<tr>
<td>Management System</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For more information, see [Cloud offerings and subscriptions](#) in the online Help.
Perpetual licenses

When you purchase a perpetual license for Studio 2021, the initial cost may be higher. However, the license does not expire and you own the software outright, meaning you may use it for many years to come.

You will receive updates and service releases for Studio 2021 for as long as SDL supports the version. Should you wish to upgrade to future editions of Studio, you’ll need to pay for the upgrade. Access to SDL Support is available through a Support and Maintenance Agreement (SMA) at an additional cost. The following perpetual licenses are available:

- Professional
- Freelance
- Starter
- Express
- Workgroup

Professional

SDL Trados Studio Professional is the complete package that includes all available features.

If you are also working with SDL Trados GroupShare the server component of Trados Studio, this edition gives you project manager functionality designed for use in Trados GroupShare environments.

Freelance

SDL Trados Studio Freelance is limited in the following ways:

- You can only work with three target languages. However, you can open, translate and create projects in any language. Any new multilingual project that you create can include up to three target languages. If you need to use more than three target languages, create separate projects.
- You cannot use SDL Trados Studio Freelance on a computer that is part of a domain-based corporate network.
- You can open and work with project packages, but you cannot create them.
- You can add and edit translation quality assessments, but you cannot create a Translation Quality Assessment configuration for a project.
- You cannot create custom task sequences.
- You cannot apply PerfectMatch to project files.
- You cannot publish GroupShare server-based projects.
Starter and Express

SDL Trados Studio Starter and SDL Trados Studio Express both have similar functionality to Freelance. What you can do in Starter and Express depends on which workflow you are using. The following list shows the key tasks that you can perform in each workflow. Express also allows you to run Studio as part of a domain-based corporate network and have use of an unlimited number of languages.

Workgroup

If you are working with SDL GroupShare, the server component of Studio, the SDL Trados Studio Workgroup edition gives you functionality designed for use in GroupShare environments.

Other standard Studio functionality is available with the following limitations:

- You cannot create new projects.
- You cannot publish projects to SDL GroupShare.
- You cannot perform TM maintenance in Translation Memories view in Trados Studio.

Upgrade and Compatibility Information

Information for upgraders

If you currently have a previous version of SDL Trados installed, you do not need to uninstall them before installing SDL Trados Studio 2021.

The new version of the software will be installed side-by-side with previous versions of the software.

If you want to install SDL Trados Studio 2019 and SDL Trados Studio 2021 on the same computer, make sure that you install the 2019 version first.

SDL Trados Studio project and package compatibility

All versions of SDL Trados Studio 2021, 2019 and 2017 have the same project and package format.

Translation Memory Compatibility
Software

SDL Trados Studio 2021 can connect to SDL TM Server 2017-2020.

Server-based translation memories

You can use server-based translation memories created in SDL TM Server 2017-2020 directly in SDL Trados Studio 2021.

You can use server-based translation memories created in SDLX Server, SDL TM Server 2007 or earlier versions of this product in Trados Studio 2021 if you first convert them to the current format. To do this, use the Upgrade Translation Memories wizard in Trados Studio. For more information, see the SDL Trados Studio 2021 Migration Guide.

Local (file-based) translation memories

You can use local translation memories that were created in SDL Trados 2007, SDLX 2007 or earlier versions of these products in SDL Trados Studio 2021 SR1 if you first convert them to Trados Studio 2021 SR1 format. To do this, use the Upgrade Translation Memories wizard in Trados Studio. For more information, see the SDL Trados Studio 2021 Migration Guide.

MultiTerm compatibility

Software

SDL Trados Studio 2021 is compatible with any 2017-2021 version of SDL MultiTerm Desktop.

Trados Studio 2021 can connect to 2017-2020 versions of SDL MultiTerm Server.

Note: Depending on which edition of SDL Trados Studio 2021 you purchased, SDL MultiTerm 2021 may be included in the purchase. However, it is not installed automatically. If you want to install SDL MultiTerm 2021, you must run the SDL MultiTerm 2021 installer. For more information, see the SDL MultiTerm 2021 Installation Guide.

Server-based termbases

You can use server-based termbases that were created in SDL MultiTerm Server 2017-2020 directly in SDL Trados Studio 2021.
Local (file-based) termbases

If you have access to termbases from any version of SDL MultiTerm 2017-2021, you can work with them in SDL Trados Studio 2021.

You can search termbases, insert term translations into documents, add new terms to termbases and edit or delete termbase entries.

Local termbases created in MultiTerm 2009, SDL MultiTerm 2007 (7.5 and 7.x releases) or MultiTerm iX (version 6.x) can also be used in SDL Trados Studio 2021, but they must first be converted to Trados Studio 2021 format.

When you select a termbase from a version previous to SDL MultiTerm 2009 SP3/SP4 in SDL Trados Studio 2021, you are asked if you want the termbase to be converted to SDL MultiTerm 2021 format. When a termbase is converted, the converted termbase file overwrites the original termbase in the same location.

Note:

- Once a termbase has been converted to SDL MultiTerm 2021 format, it cannot be reverted to an earlier format.

- If you want to work with SDL MultiTerm 2009 (1.0, SP1, SP2), SDL MultiTerm 2007 or MultiTerm iX termbases in SDL Trados Studio 2021 and you also want to be able to open the termbases in the original MultiTerm application, create copies of the termbases before you open them in SDL Trados Studio 2021.
2

Installing SDL Trados Studio 2021
This chapter contains all the information you need to install SDL Trados Studio 2021. It describes the hardware and software requirements for running Trados Studio 2021 and provides a step-by-step guide to installing Trados Studio 2021.

**Overview**

This chapter describes the system requirements and installation steps for SDL Trados Studio 2021.

**System requirements**

To install and run SDL Trados Studio 2021 you need:

**Hardware requirements**

- A Microsoft Windows-based PC or an Intel-based Apple Mac computer running Windows as an operating system
- Up to 2.5 GB of available disk space to run the SDL Trados Studio 2021 SR1 installer
- 2 GB of available disk space to run Trados Studio
- A 32-bit (x86) or 64-bit (x64) processor
  - **32-bit (x86) OS**
    - 1 gigahertz (GHz) or faster processor
    - 8 GB RAM
    - A screen resolution of 1280x1024 pixels and 256 colors or higher
  - **64-bit (x64) OS**
    - A recent processor with dual or multi-core technology
    - 8 GB RAM
    - A screen resolution of 1280x1024 pixels and 256 colors or higher

**Optimum performance**

For optimum performance, SDL recommends using:

- 64-bit operating systems
- a recent processor with dual or multi-core technology
- 16 GB of RAM and SSD storage
- a recent Intel or compatible CPU

To successfully license Trados Studio 2021, it is important that your network adapter is enabled.
Operating systems

Operating Systems

Supported OS

- SDL Trados Studio 2021 SR1 runs on the latest build of Windows 10 and the latest updated version of Windows 8.1.
- Trados Studio also supports Windows Server 2016, Windows Server 2012 R2 and Windows Server 2008 R2 to facilitate certain scenarios, for example, where Citrix or Remote Desktop Services are used.

Limited Windows 7 support

Microsoft has recently stopped support for Windows 7. As a result, we are no longer testing Trados Studio on Windows 7.

Trados Studio continues to work on Windows 7 so you can still install and use it with this Windows version. However, to work with GroupShare and Language Cloud projects on Windows 7, make sure to first [enable TLS 1.2 as default secure protocol](#). Language Cloud and GroupShare 2017 SR1 and later only accept TLS 1.2 connections. This is to ensure the highest data security when sharing projects on SDL servers.

Unsupported OS

Trados Studio does not support earlier operating systems such as:
- Windows 8
- Windows Vista
- Windows XP
- Windows 2003 Server

Recommended OS

SDL recommends that you use Windows 10 as being the current and best supported OS from Microsoft.

Software and Internet browsers

Digital certificate requirements

All SDL Trados Studio code and installer files are digitally signed.

Make sure your list of approved root certificates is up-to-date and includes the root certificate from the Certification Authority that generates SDL's code signing certificate. At the time of writing, Studio require [DigiCert Assured ID](#) Root CA and [DigiCert Assured ID Code Signing CA-1](#).

- For computers with access to the Internet, go to [https://www.digicert.com](https://www.digicert.com) and add the new root certificate to your Trusted Root Certification Authorities certificate store. This is only available for computers running on operating systems supported by Microsoft (Windows Vista or later).
- For computers in a locked down corporate environment without access to the Internet, follow the instructions available at [https://technet.microsoft.com/library/dn265983.aspx](https://technet.microsoft.com/library/dn265983.aspx). You can also
download the specific root certificates directly from https://www.digicert.com/digicert-root-certificates.htm and apply the certificates to each locked down workstation manually or by group policy.

Upgrading from an Earlier Version of SDL Trados Studio

You do not have to uninstall an earlier SDL Trados Studio version before installing SDL Trados Studio 2021.

About the SDL Trados Studio 2021 installer

The installer for SDL Trados Studio 2021 contains the following items:

Included with the installer

- SDL Trados Studio 2021
- **SDL MultiTerm 2021 settings including SDL MultiTerm 2021 Core.** These enable you to work with SDL MultiTerm termbases without having SDL MultiTerm Desktop installed.

  **Note:** SDL MultiTerm Desktop 2021 is not included in the SDL Trados Studio 2021 installer. For more information, see the [SDL MultiTerm 2021 Installation Guide](#).

- **S-Tagger for FrameMaker** and **S-tagger for QuickSilver** framework. These conversion tools enable you to prepare FrameMaker 7 MIF files and Interleaf IASCII files for translation with SDL Translator’s Workbench, SDL TagEditor and Word. To enable these two conversion tools, install the [SDL Trados Compatibility and Migration Power Pack](#) after installing Trados Studio. This is a free app that you can add from the **Add-Ins** tab > SDL AppStore. After installing the app, launch the S-Tagger components from **File** > **Legacy DTP Formats**.

Prerequisite software

For Trados Studio 2021 SR1 to work, there are a number of other pieces of software that need to be present on your computer. Most of these are also used by other applications and you probably have them already. However, if they are not present, they will be installed automatically. A complete list of the prerequisite software is given below.

Prerequisite software

The SDL Trados Studio 2021 installer will install the following software, if it is not already present on your computer:

- Microsoft .NET Framework 4.8
- Microsoft Visual C++ 2015-2019 Redistributable
may want to install Microsoft Word and PowerPoint for previewing translated Word and PowerPoint documents. Trados Studio also requires Microsoft Word for spell-checking.

**Important:** You must uninstall SDL Licensing Server Manager v1.0 before installing SDL Licensing Server Manager v2.0. The Trados Studio installer will stop if you do not uninstall SDL Licensing Server Manager v1.0.

### Installation location

The default installation location for SDL Trados Studio 2021 components is:

C:\Program Files (x86)\SDL\SDL Trados Studio

The *Program Files* folder on your computer may have a different name if you are using a non-English operating system.

### About the SDL Trados Studio 2021 installation

Installing SDL Trados Studio 2021 involves the following steps:

1. Install SDL Trados Studio 2021 from your SDL Account.
   
   The installer contains a number of compressed files which Trados Studio decompresses when you start the installation. Next, the actual installation takes place.

2. Activate Trados Studio.
   
   Once installed, you can start SDL Trados Studio 2021. The *Product Activation* dialog box is displayed. Here you can activate your product with a perpetual or subscription license or choose to use the 30 days trial. The trial license runs SDL Trados Studio in Professional mode for 30 days. At the end of 30 days you must activate your own license. If you do not have a valid license at that time, you can no longer use Studio. If you have purchased a Freelance, Starter, Express or Workgroup license, you may want to take advantage of the trial license as it will give you access to more functionality than your own license. For more information, see the *Trados Studio Editions* section.

   - If you downloaded the software from your SDL Account > Products & Plans, go to the location where you stored the downloaded files and run the installer from there.
   
   - If you are installing the software from a network resource, ask your system administrator for the network location of the SDL Trados Studio 2021 installer setup program.

### Installing SDL Trados Studio 2021

The installation routine for SDL Trados Studio 2021 is based on an installation wizard which guides you through the process.
Before you begin

To install SDL Trados Studio 2021, you must have local administrator rights on your computer. Once you install Trados Studio, add it to the trusted programs / exclusions list of your antivirus suite.

**Note:** The installer also supports administrative and silent installations. You can find instructions for administrative and silent installations in the “SDL Trados Studio 2021 SR1 Enterprise Deployment Guide” on page 0. For information on how to contact Customer Support, see [https://gateway.sdl.com](https://gateway.sdl.com).

Downloading the installer

**Procedure**

1. Go to the SDL Account website, select Products & Plans > Downloads.
2. Find the SDL Trados Studio 2021 entry in the product list and select Download next to it.

   **Note:** If you encounter any problems downloading the file, select *Alternative download via FTP* to download the file from an FTP side instead.

3. Save the installer to a preferred location.

Running the installer

**Procedure**

1. Run the self-extracting installation executable file. When all of the installation files have been decompressed, the first page of the SDL Trados Studio 2021 installer is displayed.
2. Select Accept. The installer files are extracted to your computer. When all of the installer files have been extracted, the License Agreement page is displayed.

   **Note:** If you do not have Microsoft .NET Framework 4.8 installed, this is installed now and you may be asked to restart your computer.

3. Accept the license agreement and select Next. A screen listing all of the components that will be installed is displayed.
4. The installer installs the components and indicates the progress of the installation.
5. When the installation is complete, a confirmation dialog is displayed. Select OK. SDL Trados Studio 2021 is now added to the Windows Start menu under SDL Trados Studio 2021.
After Installation

When you first start SDL Trados Studio, the following windows help you set up SDL Trados Studio for first time use: Product Activation and SDL Trados Studio Setup Wizard.

1. The Product Activation dialog, where you can activate SDL Trados Studio or choose to use the 30 days trial. For more information on licensing SDL Trados Studio, click the Help button on this dialog or go to the SDL Licensing Help.

2. The SDL Trados Studio Setup wizard, where you can:
   a. Specify your user details for this instance of SDL Trados Studio.
   b. Specify your user profile for this instance of SDL Trados Studio.
c. Start participating in the SDL Customer Experience Improvement Program.

d. Load a sample project in order to explore the SDL Trados Studio functionality at startup.
Logging an Installation

The installation is logged automatically. Log files are created here:

%ALLUSERSPROFILE%\Application Data\SDL\Chainer\Logs

Software updates

Some software updates to the application can be downloaded from within SDL Trados Studio or software updates can be automatically checked for and downloaded when SDL Trados Studio is started.

You can specify how you want SDL Trados Studio to detect application updates or your system administrator can specify a group policy for all users.

Temporary directory

Software updates are downloaded to the following temporary directory: %TEMP%\Studio16Updates. After the update is installed, you can delete the files from this location.
Individual User Software Updates

An individual user of SDL Trados Studio can do the following:

- Specify that they want to check for software updates when SDL Trados Studio starts. They can do this on the Automatic Updates page of the Options dialog box.
- Manually check for updates by selecting Help > Check for Updates from the ribbon in SDL Trados Studio.

**Note:** If either of these options is unavailable, the system administrator has set a group policy that enables or disables checking for software updates.

Group Policy Software Updates

SDL Trados Studio includes a feature that notifies users of the availability of software updates and gives them the option to install the updates on their own computer. The system administrator can set a group policy that controls the way this feature works. You can choose to:

**About this task**

- Enable automatic checking for updates. When you choose this option, an automatic check for updates is made every time a user starts the application. When an update is available, the user is prompted to apply the update to their installation.
- Enable user control of checking for updates. When you choose this option, the users can enable automatic checks for updates (these take place whenever the application is started) and they can also check for updates manually at any time. When an update is available, the user is prompted to apply the update to their installation.
- Disable all checks. This option means that automatic checks for updates will not be performed and users cannot perform manual checks either. You should choose this option if you want to control the application of updates centrally.

You define a group policy by configuring the AutoUpdate.adm file in the Group Policy dialog box.

To define a group policy (note that the screenshots here may vary slightly, depending on the operating system that you are using):

**Procedure**

1. Locate the AutoUpdate.adm file.
   The default location for this file is:
   \%ALLUSERSPROFILE\Package Cache\SDL\SDLTradosStudio2021
2. Select Start > Run and enter the following command:
gedit.msc
3. The Group Policy dialog box is displayed. Right-click on Computer Configuration > Administrative Templates and select Add/Remove Templates from the shortcut menu.
4. The **Add/Remove Templates** dialog box is displayed. Click **Add** and browse to the location of the **AutoUpdate.adm** file.

5. Click **Close** when the template is added.

6. **Computer Configuration > Administrative Templates > Classic Administrative Templates (ADM) >SDL Applications > SDL Trados Studio 2021** is added to the navigation tree. Select SDL Trados Studio to display its settings on the right.

7. Double-click on the **Enable Autoupdate** setting.

8. The **Enable Autoupdate** dialog box is displayed. Select one of the following options and click **OK** to save the group policy:

   - **Not Configured** - The user can choose to enable or disable checking for application updates automatically when the application starts and can also manually check for application updates.
   - **Enabled** - SDL Trados Studio checks for updates automatically when the application starts. The user cannot disable the automatic updates option. The user can also manually check for application updates.
• **Disabled** - Automatic checks for application updates and manual checks for updates are disabled. The user cannot enable either of these options.

Logging a Software Update

The update is logged automatically. There are two log files that are created.

The first log file is created when checking for updates and downloading installer for the update. This log file is located here:

```
%ProgramData%\SDL\SDL Trados Studio\Studio16\Updates
```

The other log file is created during the installation of the update and is located here:

```
%temp%\studio16updates
```
Removing your Software Update

If you encounter any problems after updating your software, you can remove the update.

To remove your software update:
1. From the **Start** menu on your computer, choose **Panel > Settings > Control**.
2. In the **Control Panel**, select **Add or Remove Programs** or **Programs and Features**.
3. Ensure that the **Show updates** option is selected.
4. Select the software update from the list of programs and click **Remove**.
5. Follow the on-screen instructions to remove the software update.

**Note:** In addition to removing the update, clear the **Automatically check for updates when the application starts** check box on the **Automatic Updates** page of the **Options** dialog box. This disables the option and prevents the installation of the update again.

Maintaining Your Installation

You can repair or remove your SDL Trados Studio 2021 installation at any time.

Repairing your SDL Trados Studio 2021 Installation

Use the repair feature to repair or restore missing files or registry entries in your installation.

**About this task**
To repair your installation:

**Procedure**
1. From the **Start** menu on your computer, select **Control Panel**.
2. In the **Control Panel**, select **Programs > Uninstall a Program**.
3. Right-click SDL Trados Studio 2021 SR1 on the list of programs and select **Uninstall / Change**.
4. Select **Repair**.
   - This starts the Windows Installer which runs the repair process.
5. When the process is complete, select **OK**.

Removing SDL Trados Studio 2021

Before uninstalling, we recommend that you deactivate your product license. To do this, go to **Help > Product Activation** in the application.
To uninstall:

Procedure
1. From the Start menu on your computer, select Control Panel.
2. In the Control Panel, select Programs > Uninstall a Program.
3. Right-click SDL Trados Studio 2021 SR1 on the list of programs and select Uninstall/ Change.
4. Select Uninstall.
   This starts the Windows Installer which runs the repair process.
5. When the process is complete, select OK.

Customer support
To contact Technical Support, connect to the Customer Support Web Portal at https://gateway.sdl.com
and log a case for your SDL product. You need an account to log a case. If you do not have an account,
contact your company’s SDL Support Account Administrator.

What's next?
The instructions in the SDL Trados Studio Video Help Series and the Quick Start Guides will quickly
get you started with SDL Trados Studio.

You can access these and more helpful resources at https://docs.sdl.com/SDLTradosStudio

If you have some existing translation resources, translation memories for example, you should migrate
them to the SDL Trados Studio 2021 format. Converting or upgrading existing translation resources so
that you can work with them in Trados Studio 2021 is described in the SDL Trados Studio 2021
Migration Guide.
Acknowledgments
SDL Trados Studio includes open source or similar third-party software.

**#ziplib**

#ziplib (SharpZipLib, formerly NZipLib) is a Zip, GZip, Tar and BZip2 library written entirely in C# for the .NET platform. It is implemented as an assembly (installable in the GAC), and thus can easily be incorporated into other projects (in any .NET language).

**Apache log4net**

The Apache log4net library is a tool to help the programmer output log statements to a variety of output targets. log4net is a port of the Apache log4j™ framework to the Microsoft® .NET runtime.

**Hunspell**

Hunspell is the spell checker of LibreOffice, OpenOffice.org, Mozilla Firefox 3 & Thunderbird, Google Chrome, and it is also used by proprietary software packages, like Mac OS X, InDesign, MemoQ, Opera and SDL Trados Studio.

**ICU (International Components for Unicode)**

ICU is a mature, widely used set of C/C++ and Java libraries providing Unicode and Globalization support for software applications. ICU is widely portable and gives applications the same results on all platforms and between C/C++ and Java software.

**SafeNet Sentinel**

SafeNet’s Sentinel software licensing products and software protection solutions provides software publishers control and visibility into how their applications are deployed and used.

**Spring.NET**

Spring.NET is an application framework that provides comprehensive infrastructural support for developing enterprise .NET applications. It allows you to remove incidental complexity when using the base class libraries makes best practices, such as test driven development, easy practices.

**WiX**

The WiX toolset builds Windows installation packages from XML source code. The tool-set integrates seamlessly into build processes.

**Xerces-C++**

Xerces-C++ is a validating XML parser written in a portable subset of C++.